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Information in this document is subject to change without notice and does not represent a 

commitment on the part of WheelsBridge AB. No part of this manual may be reproduced or 

transmitted in any form or by any means, electronically or mechanically, including 

photocopying and recording, for any purpose without the express written permission of 

WheelsBridge AB. 

 

Any use or application of WheelsBridge AB products must be performed by properly trained 

and qualified personnel. WheelsBridge AB takes no responsibility for action taken on the 

basis of information derived from the use of the product described in this manual or from 

consequential damages in connection with the furnishing, performance or use of this material. 

 

Licensee’s limited rights are governed by the license agreement between WheelsBridge AB 

and MathWorks. Licensee may not modify or remove any license agreement file 

(MarthWorks or third party) that is included with the MCR Libraries (“MCR Library 

License”). Licensee of this Application accepts the terms of the MCR Library License. 

 

The TiVi700 Tissue Viability Imager is patented and/or patents are pending in several 

countries. 

 

The TiVi700 Tissue Viability Imager is not registered as a Medical Device. It is intended for 

research applications only. 

 

 

WheelsBridge is a registered trade mark. 
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Part 1 – Introduction 

 

The TiVi700 Analyzer is the analysis part of the TiVi700 Tissue Viability Imaging 

system. The TiVi700 Analyzer analysis sequences of photos and creates a TiVi image 

mapping the skin red blood cells concentration for each photo. The TiVi 700 

Analyzer is composed of two main pages – the Show/Crop page and the Movie/View 

page – described in further detail below. 

 

The TiVi700 software runs on 64 Bit computers only. 

 

 

Part 2 – Menu Items 

 

1. The File menu. 

a. Camera – Opens the TiVi700 Camera software for capturing of TiVi photos. 

The TiVi700 Camera software is further described in the TiVi700 Camera 

manual. 

 

b. Open A Photo – opens a new Photo in the Photo window. This window can 

be used as a reference to the Photo and Image being displayed in the TiVi700 

main window. Multiple Photo windows can be kept open simultaneously, 

moved to outside the main window and rescaled to a suitable size. To rescale 

an open window place the mouse pointer at the border of the window (the 

pointer changes to a double arrow), press the left mouse button and drag the 

mouse to a new position. 

 

 

 
 

c. Open TiVi Chart - opens a TiVi Chart saved from inside the TiVi Chart 

window. 
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d. Projects  New TiVi Project – opens a new TiVi Project. 

 

e. Projects  Open TiVi Project – opens an existing TiVi Project. 

 

f. Save As – for saving the actual sequence of Photos as displayed in the 

TiVi700 Analyzer window. This command is useful for saving the sequence 

of Photos in a different folder or under a new name. Saving regions of interest 

(ROIs) is done by use of the Crop & Save command in the Crop Images 

frame. All relevant parameter settings are saved together with the Photos in 

such a way that the next time the Photos are loaded, the associated TiVi 

Images will be displayed under the view angle and with the same mask 

settings,  upper and lower limit as when they were stored. This is equivalent to 

saving the actual Mask settings of the Images.  

 

g. Load ROIs – loads a selected set of ROIs. This set of ROIs is accepted only 

if the size of the actual photo is the same as the photo in which the ROIs were 

originally generated.  

 

h. Save ROIs – saves the present set of ROIs to file. 

 

i. Photo resolution – opens a new window that allows the user to save a 

sequence of the actual photos at lower resolution than the original photos. 

Working with the sequence of photos at lower resolution speeds up the data 

analysis procedures and is useful when a first overview of data is made. In the 

Photo Resolution window the user can set the desired resolution of the photos 

and save these photos to file under a new name. 

 

j. Photo rotation – opens a new window that allows the user to rotate the photos 

a selected number of degrees and save a sequence of actual photos rotated to 

this degree. These rotated photos can be saved to file under a new name. 

 

k. TiVi Pre-Processor – opens a new window that allows the user to align the 

object in the individual photo before analysis. For further information please 

see the separate TiVi Pre-Processor manual.  

 

l. Export Image – exports the raw data associated with the Image displayed to a 

file that can be read by Excel® or by MATLAB® for further processing. 

Select if the entire sequence of photos or just the actual image are to be saved. 

Note that the Excel® decimal delimiter must be a dot and not a comma. 

 

m. Exit – opens a dialog window that prompts the user to confirm the close of the 

TiVi700 Analyzer window. 

 

2. The Edit menu. 

 

a. Activate Pigm Comp – allows the user to suppress the influence of pigmented 

spots on the TiVi-image. Fine-tuning is made by the Pigmentation 

Compensation on slider. 

 

b. Deactivate Pigm Comp – deactivates the pigmentation compensation settings. 
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c. Copy Photo – opens a Photo window from which the Photo and Photo Data 

can be copied to the Clipboard.  

 

d. Copy Image – opens an Image window from which the Image and Image 

Data can be copied to the Clipboard. 

 

e. Circle ROI / Rect ROI - sets the region of interest to circular or rectangular 

shape. 

 

f. Freehand ROI – draws ROI by use of the mouse to user-selected shape. 

 

g. Common ROI – all ROI operations are applied to all photos in the sequence. 

 

h. Individual ROI – No Lock on – when first drawn, the ROI is applied to all 

photos in the sequence. When a ROI is moved or stretched, this maneuvre 

applies only to the ROI in the actual Photo. By this arrangement a slight 

movement of the object in one or more photos can be compensated for by 

moving the ROI(s) to the correct position. When a ROIs is removed it is 

removed from all photos in the sequence. The individual ROIs are stored in a 

3-dimensional matrix saving the actual photo file number, the ROI number and 

the ROI coordinates. When a ROI is saved, this matrix is saved with a prefix 

identical to the actual photo prefix to which a user selected sub-prefix is added. 

 

i. Individual ROI – Lock on White Spot – to keep the ROIs locked on specific 

positions on the target tissue even if the target is moving in relation to the 

camera. Start with placing a round white marker (a paper clip with a diameter 

of about 5 mm will do well) on the target tissue before capturing the photos. In 

the analysis – with the setting to lock on to the white spot – the system 

automatically finds the brightest spot and uses this as an anchor point for the 

ROIs in each photo. Draw ROIs and then click the Automatic button to scan 

through the photos. The ROIs should now appear locked in relation to the 

white spot in the photos. This feature is particularly useful when making ROI 

analysis on moving targets and assists in calculating the average ROI values 

from the same anatomical sites even though the target position may have 

changed in relation to the camera.  

 

j. Adjust ROIs – sets the size of all ROIs to the size of the last set (white) ROI. 

The upper left corner position remains unchanged in all ROIs. 

 

k. Set ROI – opens the ROI setting window from which it is possible to 

manually set the upper left and lower right coordinates of the last selected 

(white) ROI. 

 

l. ROI Naming – use to give every ROI a unique name. 

 

m. Remove Selected Area – to remove areas selected by the ROIs from the 

photo. Draw ROIs around sections of the photo that is to be removed. Then 

click Remove Selected Area in the Edit pull-down menu. The new photos are 

saved in the folder RSA (Remove Selected Area) located in the folder of the 
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original photos. The new photos are given the prefix “RSA” followed by their 

original name. These new photos can be treated as standard TiVi-photos and 

when they are uploaded the selected areas are displayed in turquoise colour in 

the photo and as background in the corresponding TiVi image. This feature is 

useful for eliminating areas in the original photos that may distort the result 

such as a red spot characterizing an injection trauma at studies of the vaso-

active response to an injected substance as wells as for elimination artificially 

coloured skin. This function operates also in cascade, i.e. the generated RSA 

photo can be used as the original photo to further remove new selected areas. 

 

3. The Page Menu. 

 

a. Crop Images – to set the system to display the Step Through and the Crop 

Images frames. 

 

b. Movie – to set the system to display the Movie and the View frames. 

 

 

4. The Analysis Menu 

 

a. Single Image – displays the Single Image window.  

 

b. Group of Images – displays the Group of Images window. 

 

c. Curve Tracker – displays the Curve Tracker window. 

 

d. Gallery – displays the Gallery window. 

 

e. Image Slicer – displays the Image Slicer window. 

 

f. Cross Sectioner – displays the Cross Sectioner window.  

 

g. Profiler – displays the Profiler window. 

 

5. The Wizard Menu – to display the Wizard for automatic analysis of TiVi data. 

 

6. The DropData Menu 

 

a. Data to Sheet – to open a DropData window for inserting image data into a 

spread-sheet. 

 

b. Organizer – to open the Organizer table holding test subject data. 

 

 

7.  The Maintenance Menu. 

 

a. Window Size – changes the TiVi700 Analyzer window size between Small, 

Large and Wide Window (available only if the computer display is wide 

screen and high resolution). 
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b. Generate Subfolders / No Subfolder Generation – when many photos are 

generated as a result of image processing procedures, all photos can be stored 

in separate folders with the same name as the Prefix of the photo name. This 

feature helps to sort the individual photos and keep them separated. Click the 

Maintenance pull-down menu reading No Sub-folder generation to turn off 

this feature and click Generate Sub-folders to turn the feature on again. 

 

 

 

 

8. The Help Menu. 

 

a. About – displays the About window with information about the software 

version and WheelsBridge AB. 

 

b. License – displays the software license agreement. 

 

c. Manuals – electronic copies of the Quick Reference Manual, the Main 

Manual and the Pre-Processor Manual. 

 

i. Click e.g. the Main Manual.  This manual will now open inside the 

Abode PDF-Reader (this assumes that the Abode PDFReader is 

installed). The Abode PDFReader can be down-loaded free of charge 

from http://www.adobe.com).  

 

ii. Diminish the Adobe Acrobate Standard window so both this window 

and the TiVi700 Analyzer window are simultaneously visible on the 

screen. 

 

 
 

iii. If you for example want to retrieve information about how the First 

Photo button works, select Edit Find, print “First Image” in the edit 

box and click Enter on the computer keyboard. 

 

iv. To find the next “First Photo” position in the text, click the right arrow 

next to the edit box. 
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v. Click “X” to hide the edit text box. 

 

 

d. TiVi700 Presentation – an overview presentation of the TiVi technology. 

 

e. Demo Assistant – a full explanation of the Demo Assistant features. 

 

d. Product Sheet – displays detailed TiVi product sheet in pdf-format. 

  

e. WheelsBridge WEB – a direct link to the WheelsBridge WEB-site. 

 

f. ToolTips –displays (ON) or hides (OFF) the tooltips associated with the 

different controls and displays. 

 

g. Patents – lists TiVi patent numbers 

 

 

9. The Language Menu - to set the actual language. This information is stored between 

sessions and is automatically retrieved when a new session is initiated. 

 

10. The Tool Boxes Menu – to start individual toolboxes (optional). 

 

11. The Demo Assistant Menu – to start the interactive Demo Assistance guiding the 

User on how to use the different features of the TiVi700 Analyzer,  

 

 

 

Part 3 - Photo frame 

 

1. The Photo - loaded from file or being the result of a Show ROI click button. 

 

2. The Photo Size (in pixels) is displayed next to the Photo. 

 

3. The Actual Photo Indicator indicates in blue color the relative number of the Photo 

in the sequence that is currently displayed. 

 

4. Date indicates the date when the photo was captured. 

 

5. Time First indicates the time when the first Photo of the sequence was captured. 

 

6. Time indicates the time when the currently displayed Photo was captured as well as 

the Elapsed Time from when the First Photo was captured. 

 

7. Time Last indicates the time when the last Photo of the sequence was captured. 

 

8. ROIs displays the number of active regions of interest. 

 

9. Information about Polarization Mode, Distance to object and Zoom mode as stored 

with the photo. 
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10. When a region of interest (ROI) is drawn the Distance (in pixels) between two 

diametric corners of the ROI is displayed below the TiVi-value. 

 

 

 

Part 4 - Image frame 

 

1. The Image – calculated by the TiVi700 algorithm or being the result of a Show ROI 

button click. 

 

2. The Data Values for the displayed Image are listed to the right of the Image. Data 

Values representing the entire Image or a ROI are listed in blue color, while Data 

Values representing areas selected with the Upper Limit and Lower Limit sliders are 

listed in red color. Data Values representing a Subtraction Image are displayed in 

turquoise color, while Data Values representing a Subtraction Image with values 

within the Lower and Upper Limit are presented in gray color. Double presentation 

(x/y) for Mean indicates mean value including background (x) and only background 

(y). Double presentation (x/y) for Max and Min indicates the highest/lowest value (x) 

respectively the median value of the 10 highest/lowest values. The latter is used by the 

system in Mask calculations in order to avoid the influence of single extreme values. 

 

3. Following selection made by the Lower and Upper Limit sliders, the limits (in 

percentage) are displayed above the Image. 

 

4. The TiVi-value of the point at which the pointer is pointing in the Photo or Image, is 

continuously updated and displayed. 

 

5. The median RGB value triplet for the actual photo displayed in the Photo Frame. For 

a sequence of photos, the corresponding RGB value triplets can be exported to the 

Group Of Images window where they can be displayed in a separate colour space 

window and exported to an Excel® document. 

 

6. The Color Bar is displayed to the right of the Image and reflects the setting of the 

Color Span. 

 

 

Part 5 - Select Photos Frame 

 

1. First Photo button – to select the First Photo file of the sequence of Photos to be 

investigated from the files listed in the Open Dialog Box. The file name is displayed 

in the associated First Photo edit box. By default the Last Photo is automatically 

selected as the last photo in the consecutive sequence. The Last Photo of the sequence 

is displayed. 

 

2. Last Photo button – to select the Last Photo file of the sequence of Photos to be 

investigated from the files listed in the Open Dialog Box. The file name is displayed 

in the associated Actual Photo edit box. 
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3. Step – to select the step in the Photo sequence to be loaded. If for example the Photos 

are stored in files with names F-1000, F-1001….F-1020, setting Step to 5 loads Photo 

data for the files F-1000, F-1005, F-1010, F-1015 and F-1020. The value is selected by 

repeatedly clicking the Step button.  

 

4. Reverse – reverses the order of updating Step when the Step button is successively 

clicked. The button name toggles between Reverse and Forward.  

 

5. Clear All – clears the Photo and Image frames and prepares the system for accepting 

new Photos. 

 

6. Show First Photo and Show Last Photo – by clicking one of these radio-buttons, the 

first or last Photo and Image pair to be displayed can be selected.  

 

7. Actual Photo box – shows the name of the Photo file currently displayed. To directly 

display a specific Photo in a selected sequence, print its name in the Actual Photo 

edit box and press the Enter button on the computer keyboard. 

 

8. When the system is in Subtraction mode, the name of the file representing the Image 

to be subtracted is displayed in the Subtract Photo edit box. 

  

 

Part 6 - Step Through Frame 

 

1. Manual – by successively clicking this button, the Photos and Images are displayed 

in their respective frame, while the actual file name is shown in the Actual Photo edit 

box. 

 

2. Reverse - changes the order in which the Photos and Images are displayed when 

successively clicking the Manual button. The button name toggles between Reverse 

and Forward.  

 

3. Reset – displays the First Photo and First Image.  

 

4. Delay (sec) – dragging the slider to a new position sets a new Speed, as displayed in 

the Edit box, at which the Image sequence following clicking Automatic is 

presented. Keeping the pointer over the leftmost or rightmost arrow in the slider, with 

the left mouse button down, continuously moves the slider while the Edit box is 

updated to a new Speed setting. Alternatively print a new value in the Edit box and 

press Enter. 

 

5. Automatic – clicking this button makes the system step through the Photo sequence 

at a speed set by Delay.  Activating Automatic enables the Pause and Abort buttons. 

 

6. Pause – clicking this button while in Automatic mode, halts the Step Through 

procedure and waits for the button, now labeled Continue, to be clicked again. 

 

7. Abort – clicking this button while in Automatic mode, aborts the Step Through 

procedure.  
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8. Comments – opens the word pad associated with the actual photo / image displayed 

for further editing. When the edit process is finished click the Save &  Close button in 

the Comments 700 window to save the  edited text as meta data linked to the actual 

photo. 

 

9. Color Span – for setting the color scale of the displayed image, without changing the 

actual data values. The color scale end-points are indicated in blue (lowest value) and 

red (highest value). 

 

 

Part 7 - Crop Images frame 

 

1. Show ROI – after having selected a Region of Interest (ROI), using the 

following procedure 

 

• Place the pointer within the Photo or the Image area in the upper left 

corner of the ROI to be generated (if the ROI is to be generated in the 

Image and this is not displayed in Top View mode (azimuth = 0 and 

elevation = 90) the User is prompted to  place the system in Top View 

mode – click OK in the Warning window to proceed), 

 

• Move the pointer to the lower right corner of the ROI, while keeping the 

left mouse button pressed, 

 

• Outline the ROI by releasing the left mouse button, 

  

defines and outlines a ROI. 

 

The position of any ROI can be changed by the following procedure: 

 

When the pointer is moved over the upper left or lower right corner of a ROI the 

pointer changes shape from arrow to double arrow. When the pointer is indicated 

by a double arrow, the ROI shape can be changed by moving the pointer by use of 

the mouse with the left mouse button pressed. In Common ROI mode these 

changes are applied to all photos in the sequence. In Individual ROI mode, these 

changes are applied only to the actual photo. 

 

When the pointer is moved over the centre of a ROI, the pointer changes shape 

from arrow to four-headed arrow. When the pointer is indicated by a four-headed 

arrow, the ROI can be moved to a new position (without changing its shape) by 

moving the pointer by use of the mouse with the left mouse button pressed. In 

Common ROI mode these changes are applied to all photos in the sequence. In 

Individual ROI mode, these changes are applied only to the actual photo. 

 

 

When the pointer is positioned over the centre of a ROI as indicated by a four-

headed arrow, clicking the left mouse button causes the Erase ROI window to 
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open. If the Yes button is clicked the actual ROI is erased in all photos and the 

remaining ROIs are re-numbered and re-drawn.  

 

The actual number of ROIs is indicated by the ROIs indicator in the upper left 

corner of the Photo Frame. This number should always be the same as the number 

of ROIs displayed in the Photo. If not, click the Refresh button. 

 

Note that a new ROI can also be outlined in the Image, but its border is always 

indicated in the Photo. 

 

Switching between rectangular and circular ROIs is made by clicking Circle ROI 

or Rect ROI in the Edit pull-down menu. 

 

The last drawn (white) ROI can now be displayed by clicking the Show ROI 

button. Again clicking the same button, now labeled Undo Show ROI, returns the 

system to its original mode. If new ROIs are successively generated the latest 

generated ROI is always displayed in white color while other ROIs are displayed 

in different colors so the ROIs can be easily identified. Clicking the Refresh 

button clears the Photo from ROI layouts. The ROIs can be drawn either in the 

Photo or in the Image. 

 

By use of Adjust ROI in the Edit pull-down menu, the size of all ROIs can be 

made identical to the last ROI generated (white outline). The upper left corner of 

all ROIs is kept at the original position.  

 

The coordinates of the upper left and lower right corner positions of the last ROI 

generated (white) can be set manually from the ROI700setting window opened by 

the Set ROI command in the Edit pull-down menu. 

 

Provided at least one ROI exists, more ROIs of the same size can be automatically 

generated by placing the pointer at the upper left corner of the ROI to be generated 

and then clicking the left mouse button. 

 

2. Crop & Save – with the system in the Show ROI mode, clicking the Crop & 

Save button, opens the Save As dialog box. Select a folder (or alternatively 

generate a new folder) and a file name and click the Save button to save the 

sequence of (cropped) Photos. The saved sequence of cropped Photos adds the 

file name as a prefix to the old file name. All relevant parameter settings are saved 

together with the cropped Photos in such a way that the next time the (cropped) 

Photos are loaded, they will be displayed under the view angle they were stored. 

Furthermore Upper and Lower Limits are saved with the Photos so the actual 

threshold settings are retrieved. This is equivalent to saving the actual Mask 

settings of the Images. 

 

3. Overlay – after having selected upper and lower threshold by way of the Upper 

Limit and the Lower Limit slider, clicking the Overlay button, displays the actual 

reduced image areas superimposed on the photo, the latter now displayed in gray 

scale. When the Automatic button is clicked the selected image area is displayed 

superimposed throughout the entire photo sequence. 
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4. Subtract – click this button to subtract the Actual Image from all the other 

Images in the sequence pixel by pixel. Clicking Subtract evokes the Subtracted 

Photo edit box displaying the name of the file representing the Image to be 

subtracted. To leave the Subtraction Mode again click the same button now 

named Undo Subtract. 

 

5. Upper Limit – dragging this slider to a new position as displayed in the associated 

Edit box, sets the upper limit of Data Values to be included in the Image and 

displays this Image. Alternatively print a new value in the Edit box and press 

Enter. 

 

6. Lower Limit – dragging this slider to a new position as displayed in the associated 

Edit box, sets the lower limit of Data Values to be included in the Image and 

displays this Image. Alternatively print a new value in the Edit box and press 

Enter. 

 

7. Mask – FiFr (Fixed Fraction) selects the fraction of the actual Image set by 

Lower Limit and Upper Limit and applies this Mask to all Images in the 

sequence. Fr (Fraction) selects the fraction set by Lower Limit and Upper Limit 

and applies this selection when setting the individual Masks to the Images. Fi% 

(Fixed Percentage) uses a Mask based on the values set by Lower Limit and 

Upper Limit in the actual Image and applies this Mask to all Images in the 

sequence. % uses individual Masks to all Image based on the Lower Limit and 

Upper Limit values. Level uses the set Lower and Upper Limits as absolute 

levels. 

 

8. Refresh – clears the Photos from ROI selections. 

 

9. Reset Mask – resets the actual mask. 

 

 

Addendum: The Crop Images frame is accessible from the Show/Crop Page. The 

ROI selection, Upper Limit and Lower Limit selection may be combined to select 

Image data within a certain range and physical region of interest in the Photo. On the 

basis of this selection, the Data Values are calculated for further presentation in the 

Group of Images window. The Mask is particularly useful for automatically setting 

the Region of Interest and forms the core of increasing productivity in many 

applications. The possible settings (FiFr, Fr, Fi%,% and Level) is further illustrated in 

the Figure below. If an image contains single high values the Fi% and % setting may 

display a low number of active points within the Mask because very few values reach 

the set percentage Limit of the highest value. This problem is overcome when the FiFr 

and Fr settings are used because these settings will always display a number of points 

within the Mask corresponding to the fraction of the entire number of points in the 

image as set by the Limit. 
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Part 8 - Movie frame 

 

1. Create Movie – creates a Movie from the sequence of  Images  selected. While 

building the Movie, the system displays the different Image frames that will combine 

into the resulting Video Clip. 

 

2. Interpol Video – generates a video from the actual image sequence with a length (in 

seconds) that is set in the Video-Length window. Insert the desired length of the video 

in the edit text box and click the OK-button in the Video-Length window. The video 

is generated by calculating interpolated images in between the real images in the 

sequence. This procedure is particularly useful when a video is to be presented in e.g. 

a Power Point presentation. 

 

3. Save Movie – saves the created Movie in a file and folder set in the Save As dialog 

window. 

 

4. Load Movie – loads a previously created and saved Movie. 

 

5. Speed – dragging the slider to a new position sets a new Speed, as displayed in the 

Edit box, at which the Movie runs following clicking the Start Movie button. 

Keeping the pointer over the leftmost or rightmost arrow in the slider, with the left 

mouse button down, continuously moves the slider while the Edit box is updated to a 

new Speed setting. Alternatively print a new value in the Edit box and press Enter. 

 

6. Start Movie –starts the Movie created by or loaded by the system.  

 

7. Save As Images – splits up a video-clip into individual photos and saves these to file. 
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Part 9 - View Frame 

 

1. Azimuth – dragging the slider to a new position changes the azimuth presentation 

angle as displayed in the associated Edit box. Keeping the pointer over the leftmost 

or rightmost arrow in the slider, with the left mouse button down, rotates the Image 

while the Edit box is continuously updated. The Image is rotated stepwise by 

successively clicking any of the arrows. Alternatively, a new value can be written in 

the Edit box. Activate the new settings by pressing Enter. 

 

2. Elevation – dragging the slider to a new position changes the elevation presentation 

angle as displayed in the associated Edit box. Keeping the pointer over the leftmost 

or rightmost arrow in the slider, with the left mouse button down, rotates the Image 

while the Edit box is continuously updated. The Image is tilted stepwise by 

successively clicking any of the arrows. Alternatively, a new value can be written in 

the Edit box. Activate the new settings by pressing Enter. 

 

3. Plot Density - dragging the slider to a new position changes the density of the plot 

grid associated with the Image presentation as displayed in the Edit box. Selecting a 

low Plot Density, speeds up the update procedure of the Image while at the same 

time the resolution is reduced, without affecting the Data values.  

 

4. Rotate Azim – clicking this button rotates the Image successively from 0 to 360 

degrees. A low Plot Density speeds up the procedure. Interrupt the rotation 

procedure by clicking the button now labeled Stop Rotate. 

 

5. Rotate Elev – clicking this button changes the view angle under which the Image is 

seen over the range 0 to 90 degrees. A low Plot Density speeds up the procedure. 

Interrupt the rotation procedure by clicking the button now labeled Stop Rotate.  

 

6. Plot Method – selecting Surface, Interpolated and Mesh respectively displays the 

Image using different plot methods. The default Plot Method is Surface. 

 

Addendum: Setting a specific View Angle, in the View frame, makes the system use this 

View Angle during all succeeding Image operations, until selecting a new Azimuth or 

Elevation angle again changes it. Selecting a low Plot Density speeds up all Image 

processing operations. 
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Part 10 - Single Image Window 

 

      Clicking Single Image in the Analysis menu evokes the Single Image window. 

 

        
 

 

 

1. The Mask selection, Date and Time indicate how the Image was generated and when 

the Photo was captured. Relevant parameters are displayed in the Statistics panel. 

 

2. Number of Cells – dragging the slider to a new position, as indicated by the Edit box, 

selects a new number of cells used for displaying the spatial variability of the Image 

data points. Alternatively print a new value in the Edit box and press Enter. 

 

3. Distribution – displays the distribution of Image Data points using the number of 

cells set by the Number of Cells slider. The height of the bars represents the number 

of Image data points in each cell.  

 

4. Cumulative – displays the cumulative distribution of Image data points. 

 

5. Close – to close the Single Image window. 

 

 

Addendum: The Single Image window is useful for identifying outlier Image data values and 

for the interpretation of the Data Values generated by the system. Multiple copies of the 

window can be kept open at the same time.  
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Part 11 - Group of Images Window 

 

      Clicking Group of Images in the Analysis menu evokes the Group of Images window. 

 

       
 

 

1. The Mask ON/OFF, Mask selection, Subtraction mode. Mask ON/OFF, Date and 

Time indicate how the Image was generated and when the Photos were captured. If 

applicable Upper and Lower Limits are displayed. 

 

2. Radio buttons in the X-Scale  panel – checking these radio-buttons  selects the x-

axis coordinates to be displayed in the diagram. 

 

a. Checking File Number displays the file number of the file along the x-axis. 

b. Checking Log Scale displays the values along a logarithmic x-scale. 

c. Checking the Image number displays the image number of the file along the x-

axis. 

d. Checking El. Time (Hr) displays the elapsed time in hours, minutes and seconds 

along the x-axis. 

e. Checking El. Time (Sec) displays the elapsed time in seconds along the x-axis. 

 

The diagram is automatically updated when a radio-button is changed. The system 

preserves the setting of the individual check boxes until changed again by the user. 

 

3. Check Boxes in the Statistics panel – checking these check-boxes selects the 

following parameters to be displayed in the diagram. 
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a. Checking SD displays the standard deviations. 

b. Checking Max Value displays the maximum values. 

c. Checking Min Value displays the minimum values. 

. 

4. Display pull-down menu – selecting diagram y-scale. 

 

5. Smoothing pull-down menu – selecting Medium displays all values moderately 

smoothed, selecting None displays all values un-smoothed and selecting More 

displays all values strongly smoothed. 

 

6. RGB Values – to open the Colour Space window and display the RGB values. 

 

7. Export Data – to export values to and Excel spreadsheet (including RGB triplet 

values. 

 

8. Close – closes the Group of Images window.  

 

 
 

9. The RGBvalues Colour Space window displays the RGB triplet values in either the 

RGB or the HSV colour space. 

 

10. RGB radio-button – click to display the triplets in the RGB colour space. 

 

11. HSV radio-button – click to display the triplets in the HSV colour space. 
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12. The Start-point displays the triplet for the first photo in the sequence. The Stop-point 

displays the triplet for the last photo in the sequence. 

 

 
 

Part 12  - Curve Tracker Window 

 

Clicking Curve Tracker in the Analysis menu evokes the Curve Tracker window. 

 

        
 

1. If more than one Image is loaded, the Curve Tracker opens in the Curve mode, as 

displayed above. 

 

2. In the Date & Time panel the date and time of photo capturing is displayed. 

 

3. In the White Track panel, the statistics (SD, Max Value and Min Value) of the last 

identified region of interest (always displayed in white color), can be activated or 

deactivated by use of the check-boxes entitled SD, Max Value and Min Value. 

 

4. In the Subtract First Image panel, checking the Sub First Image check-box 

subtracts the first image values from all the res and all curves start from the zero level. 

 

5. Radio buttons in the X-Scale panel – checking these radio-buttons  selects the x-

axis coordinates to be displayed in the diagram. 

 

a. Checking File Number displays the file number of the file along the x-

axis. 
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b. Checking Log Scale displays the values along a logarithmic x-scale. 

c. Checking the Image number displays the image number of the file along 

the x-axis. 

d. Checking El. Time (Hr) displays the elapsed time in hours, minutes and 

seconds along the x-axis. 

e. Checking El. Time (Sec) displays the elapsed time in seconds along the x-

axis. 

 

6. When clicking the rectangular squares in the Track Displayed panel, the 

corresponding curve is temporary hidden. Clicking the actual square once more again 

displays the curve. 

 

7. In the Display pull-down menu, the scale of the y-axes is set. 

 

8. Smoothing pull-down menu – selecting Medium displays all values moderately 

smoothed, selecting None displays all values un-smoothed and selecting More 

displays all values strongly smoothed. 

 

9. Export Data button – to export data to an Excel spreadsheet. 

 

10. Close – to close the Curve Tracker window. 

 

11. If only one Image is loaded, the Curve Tracker opens in the Statistics mode, as 

displayed below. 
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12. In the Select Mode panel clicking the Curves radio-button displays the curve mode 

diagram. 

 

13. In the Select Mode panel clicking the Bars radio-button displays the bar diagram. 

 

14. Clicking the Step Through button displays the successive set of ROIs for different 

Images. 

 
 

Part 13 - Gallery Window 

 

Clicking Gallery in the Analysis menu evokes the Gallery window. 

 

        
 

1. The Gallery window displays the entire sequence of Images in color representation as 

selected by Plot Color in the View frame. The layout automatically adapts to the 

number of Images included in the sequence. In total 150 Images can be displayed in 

the Gallery window. The actual number of the Image is displayed below respective 

Image. 

 

2. Close – to close the Gallery window. 
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Part 14 - Image Slicer Window 

 

1. The Image Slicer window is evoked by clicking Image Slicer in the Analysis pull-

down menu. 

 

       
 

2. The right-most display areas (Photo and Image) in the Profile Level panel display the 

position of the actual slice. 

 

3. The left-most display area displays the Profile of the actual slice. 

 

4. The positions of the actual slice are controlled by the sliders, edit boxes and buttons 

within the Horizontal and Vertical panels. 

 

5. Pressing the right-most or the left-most arrow in the slider moves the slice to the right 

(Vertical) or up (Horizontal) respectively to the left (Vertical) or down 

(Horizontal). The actual position is displayed in the Edit box. 

 

6. Dragging the slider moves the slice directly to the target position. 

 

7. Clicking Scan makes the slice scan through the complete image. 

 

8. The Scan procedure can be halted at any time by clicking the Pause button. The Scan 

procedure is continued by clicking the same button now labeled Cont. 

 

9. The Scan procedure can be terminated at any time by clicking the Stop button. 
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10. The Display pull-down menu can be set to either Fix, Auto or Fit. Fix mode implies 

that the Y-axis is fixed with the end-points set to the maximum and minimum value 

respectively. Auto mode implies that the upper end-point of the Y-axis adapts to the 

maximum value of the actual Profile. Fit mode implies that both the upper and lower 

end-point of the Y-axis adapt to the actual Profile maximum and minimum values. 

 

11. Clicking the Hold button implies that each new Profile is superimposed on the 

previously displayed Profiles. Clicking the same button again, now labeled Erase, 

returns the system to displaying only a single Profile. 

 

12. Clicking the Close button closes the Image Slicer window. 

 

13. The File Name, Date and the Time of Image capturing are displayed in the left side 

of the Control Panel. 

 

14. The Image size as well as the Maximum and Minimum value of the actual Profile 

are displayed in the top right corner of the Profile Level window. 

 
 

Part 15 - Cross Sectioner Window 

 

To display a sequence of cross sections, a specific Cross Section of the Images needs to be 

loaded. Proceed as follows. 

 

1. Load a Photo sequence (in this case the test image sequence A-0001 to A-0071 stored 

in the MN DATA folder). 

 

2. Select Cross Sectioner from the Analysis pull-down menu. The Cross Sectioner 

Prepare 700 window will now open. 
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3. Select Vertical Line or Horizontal Line by checking the associate radio-button. 

 

4. Click somewhere in the Image to generate the line. 

 

5. Click Accept to accept the line selection. The Cross Sectioner 700 window will no 

open. 

 

       
 

6. Date & Time panel  - displays date and time of photo capturing. 

 

7. X-Scale panel – check radio-button to select t x-scale. 

 

a. Checking File Number displays the file number of the file along the x-axis. 

b. Checking the Image number displays the image number of the file along the x-

axis. 

c. Checking El. Time (Hr) displays the elapsed time in hours, minutes and 

seconds along the x-axis. 

d. Checking El. Time (Sec) displays the elapsed time in seconds along the x-axis. 

 

8. Display panel – check the Hide Grid and Hide Axis to hide the grid and/or the axis. 

 

9. Control Panel 

 

a. Check Top View, Side View, Perps 1, Persp 2, Persp3 or Persp 4 to select 

the view angle. 

b. Drag the Color slider to alter the diagram color scale. 

c. Select Plot Method in the Plot Method pull-down display. 

d. Export Data – to export data to Excel. 
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e. Close – to close the window. 

 

10. First and Last File Name, Cross Section Number and Mode are displayed above the 

Cross Section Map panel. 

 
 

Part 16 - Profiler Window 

 

The Profiler is useful for displaying and analyzing circular erythema and blanching reactions. 

 

1. Load a Photo sequence (in this case the test image sequence UVB-0001 to UVB-0004 

stored in the PROFILER FILES. 

 

2. Select Profiler form the Analysis pull-down menu. Click the Show Last Photo radio-

button. The Profiler window should now look like: 

 

 
 

3. Click the Place High button. After a while 5 concentric rings will be automatically 

placed around the peak value of the reaction. 

 

4. Drag the Number of Rings slider to the right until the edit box displays 10. Drag the 

Size of Rings slider to the right until the edit box displays 130. The Profiler window 

should now look like (alternatively insert the number directly in the edit box and press 

Enter) : 
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5. Select Curve under the Plot Method popup menu. The Profiler window should now 

look like:  
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6. The Curve displays the average TiVi value within the different rings and the 

associated standard deviation. 

 

7. Click the Step Through button repeatedly to step through the sequence of photos 

uploaded. 

 

8. Click the Display Curves button to display all curves in a separate window: 

 



TiVi700 Analyzer Manual 

 

TiVi700Analyzer ver1.4 Page 29 

 

 
 

9. In the Control panel: 

 

a. Show SD – to display or hide the standard deviation bars. 

b. Display – to set the y-axis. 

c. Display Bars – to display the result as a bar graph. 

d. Close – to close the window. 

  

 

10. Click the Display Bars button to display the result as a bar-graph.  

a. Display Panel  

i. Mean Intensity – to display the mean intensity. 

ii. Mean Intensity & SD – to display standard deviations on the mean 

value bars. 

b. Mode Panel  

i. Curve Number – displays curve number along x-axis. 

ii. Ring Number – ring number along the x-axis. 

c. Bar Graph Panel 

i. 2D - displays the diagram in 2D mode. 

ii. 3D – displays the diagram in 3D mode (can be rotated). 

d. Pallette pull-down menu –to select bars color palette.  

e. Close button – to close the window. 

 

11. Export Data – exports data to an Excel spreadsheet. 
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Part 17 – Wizard 

 

The Wizard is intended for rapid and automatic analysis of a sequence of Images in which 

ROIs have been drawn. The Wizard calculates the average TiVi-value inside the ROIs 

including only pixels above or below set threshold. 

 

First the Welcome to the Express Wizard is displayed in which the Above Threshold or 

Below Threshold mode can be selected and the Threshold level set. When clicking the OK 

button these values are accepted and the TiVi Chart window is displayed 

 

The TiVi Chart window displays the calculated TiVi values for each ROI and Image. 
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With Threshold = 50% and Above mode selected. 
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With Threshold = 50% and Below mode selected. 

     

                   

Part 18 – TiVi700 Chart Window 

 

 

1. Mean Values radio-button – check to display average TiVi-values. 

 

2. Median Values radio-button – check to display median TiVi-values. 

 

3. Area radio-button – check to display the surface area of individual patches. 

 

4. Mean * Area – check to display the product of average TiVi-Values and the surface 

area. 

 

5. Sub First Image check-box – check to subtract the first Image ROI TiVi-values from 

the remaining TiVi-values in the sequence of Images. 

 

6. Standard Dev check-box – check to display the standard deviations of the last (white) 

ROIs. 

 

7. Average Curve – check to display the average curve. 

 



TiVi700 Analyzer Manual 

 

TiVi700Analyzer ver1.4 Page 33 

 

8. Average Std. – check to display the standard deviation of the average curve. 

 

9. Select Reference Curve – subtracts the TiVi-values in the selected curve from al the 

remaining TiVi-values. This feature is useful to relate TiVi-values of various ROIs to 

those of a control ROI. 

 

10. First File No. Displayed – to select the first file number displayed. 

 

11. Last File No. Displayed – to select the last file number displayed. 

 

12. Smoothing – to select the degree of smoothing. 

 

13. Select X-axis – to select the x-axis scale. 

 

14. Select Y-axis – to select the y axis scale. 

 

15. % of Max Value – creates vertical lines at Images when the set percentage of 

maximum value (indicated by a dot) has been reached. 

 

16. Bar Graph – to display the result in terms of a bar graph. 

 

 

 
 

a. Display panel. 

i. Mean Int – displays the average TiVi values. 

ii. Mean Int & SD – displays the average TiVi-values with standard 

deviations. 

iii. Median Int – displays the median TiVi-values. 

iv. Area – displays the surface area of the patches 
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b. Mode panel 

i. File No. – sets the file number along the x-axis. 

ii. ROI – sets the ROI number along the x-axis. 

c. Bar Graph  panel 

i. 2D – to display a two-dimensional bar graph. 

ii. 3D – to display a three dimensional bar graph. By placing the mouse 

cursor inside and pressing the left mouse button, the BarGraph panel 

the 3D view can be altered. 

d. Pallete – to select the color scale of the bar graph 

e. Close – to close the ChartBG700 window. 

 

17. Close – to close the TiVi700 Chart window 

 

18. ROIs Displayed panel 

a. Color buttons – click a color button to temporarily hide the associated curve. 

b. Edit box – displays the time/file number/image number at which vertical lines 

crosses the curves. 

 

19. File Menu 

a. Save TiVi Chart – to save the actual TiVi700 chart (can be re-opened from 

the TiVi700 Analyzer window. 

b. Close – to close the actual TiVi Chart. 

c. Export – to export data from the TiVi Chart to an Excel spreadsheet. 

 

Above the panels information about the First File Name, Last File Name, Step, Number of 

Files, Threshold setting and Mode is displayed. 

 

 
 

Part 19 - Project Window 

 

The TiVi700 Project window displays average TiVi-values by importing these values from a 

saved TiVi700 Chart. While the TiVi700 Chart generally represents data recorded from a 

single subject, the TiVi700 Project displays average data values from up to 20 subjects. 

 

A new TiVi700 Project window is opened from the TiVi700 Analyzer window 

(FileProject New TiVi Project). 

 

An existing TiVi700 Project window is opened form the TiVi700 Analyzer window 

(FileProject Open TiVi Project). 

 

In the TiVi Project window below, seven average TiVi value curves have been uploaded 

from saved TiVi Charts (AA_CHARTGG_CHART). 
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1. Objects panel – lists all uploaded objects. 

a.  Remove object permanently by clicking on its corresponding quadrat in the 

Objects panel 

 

2. Controls panels 

 

a. Mean radio-button – click to display average values. 

b. Median radio-button – click to display median values. 

c. Area – click to display the average patch area values. 

d. Mean * Area – Click to display the product of Mean an surface area values. 

e. Average check box – check to display the average of all curves displayed. 

f. Standard Deviation check box – check to display the associated standard 

deviations. 

g. Log Scale check-box – click to display data in logarithmic scale. 

h. Smoothing – to smooth the curves displayed (Medium, None, More). 

i. Select Y-axis – to set scale of Y-axis. 

j. % of Max Value – to display vertical lines corresponding to the file number at 

which the set percentage of the maximum value (indicated by a square) is 

reached. The file number is also displayed in the color quadrat next to the 

name in the Objects panel. 

 

3. File Menu 
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a. Save TiVi Project – to save the actual TiVi Project. 

b. Export Data – to export data displayed to an Excel spreadsheet. 

c. Close – to close the TiVi700 Project window. 

 

4. Load Objects – to upload a new object to the TiVi700 Project window. Click on a 

saved TiVi700 Chart to upload the data. 

 

5. Close – to close the TiVi700 Project window. 

 

 
 

 

Part 20 - Excel Files Generated 

 

The following Excel Files are generated by the various windows of the TiVi700 Analyzer: 

 

TiVi700 Analyzer Main Window:   

Export Image:  Full Image.  

 

Group of Images Window: 

Export Data:  Mean Intensity Values, Standard Deviations, Min Intensity Values,        

Max Intensity Values 

 

Curve Tracker Window: 

Export Data:         Mean Intensity Values, Median Intensity Values, Standard Deviations, 

          Min Intensity Values, Max Intensity Values 

 

Image Slicer Window: 

Export Data: Actual profile. 

 

Cross Sectioner Window: 

Export Data: Full Image 

 

Profiler Window (Display Curves): 

Export Data: Mean Values, Standard Deviations, Points 

 

Chart Window: 

Export Data: Mean TiVi Values, Extension. 

  

Project Window: 

Export Data: Mean TiVi Values, Standard Deviations, Extension. 

  Perc-F_T: percentage, Image No for % of Max for individual ROIs
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Part 21 – Specifications 

 

Property Value 

Type  

  Camera Head Canon EOS 550D / 650D/ 700D 

  Computer 64 bit, 4GB min (8GB recom.)  

  Flexible Arm Neo-Flex 

Dimensions  

  Computer 4x26x36 cm, 3 kg 

  Camera 5x18x12 cm, 0.5 kg/ 24x16x13, 1 .5 kg 

  Flexible Arm about 50 cm, 1.2 kg 

Photo format  jpeg 

Photo size (pixels) 1728 x 2592  -  3456 x 5184 

Maximal resolution (at 30 cm) 50 micrometers 

Distance 10 cm – inf. 

Field of View (at 30 cm) 280 x 200 mm 

Maximal photos per minute 12 

Maximal number of photos in sequence 9999 

Instability  

 Temperature drift 0.35% per Degrees C 

 Drift over 2 months period < 1% 

Image uniformity in sensitivity  

 Without normalization 3% (corners) 2% (centre) 

 With normalization 0.25% /corners) 0.13% (centre) 

Distance dependence Not measurable (13 – 28 cm) 

Ambient light dependence  

 40W bulb at 50 cm distance 10% 

 11W fluorescent light source at 50 cm distance 10% 
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Part 22 - Demo Assistant 

 

The Demo Assistant is an online interactive guide to the effective use of the basic functions 

and features of the TiVi700-system. The Demo Assistant is available from the Demos 

Assistant pull-down menu. When a topic in the Demo Assistant is selected a specific topic 

demo window is opened which guides the user step-by step on how to perform certain tasks. 

 

  
 

 

The Demo Assistant includes to following topics: 

 

DEMO ASSISTANT 

TiVi File Names 

Loading Photos 

Crop & Save 

Thresholding 

Movies 

Image Subtraction 

ROI Management 

 Draw ROIs  

 Delete ROIs 

 Move ROIs  

 Stretch ROIs 

 Set ROI Parameters 

 Save & Load ROIs 

Analysis 

 Single Image 

 Groups of Images 
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 Curve Tracker 

 Gallery 

 Image Slicer 

 Cross Sectioner 

 Profiler 

Wizard 

TiVi Chart 

Project 

TiVi Pre-Processor 

Using the Demo Assistant is an effective way of getting acquainted with the basic functions 

and features of the TiVi700 system. 

 
 

Part 23   DropData 

 

The Dropdata feature is a convenient way of bringing image data in focus directly into a 

spread-sheet by a single click on a spread-sheet cell. The associated Organizer holds editable 

subject data and the subject identifiers can be exported directly to the DropData spread-sheet. 

Both the DropData spread-sheet and the Organizer spread-sheet are fully editable and both 

can be saved as Excel documents for further processing. 

The DropData / Organizer features are best explained by an example. 

Assume that the response to topical application of methyl nicotinate from three separate 

subjects has been stored in the files A-0001 – A-00071, C-0010 – C-0085 and E-0010 – E-

0095 stored in the MN DATA folder in the TiVi700 demonstration folder. 

 

1. Click the First Photo Photo button in the TiVi700 Analyzer window and select the 

A-0001 file in the MN DATA folder located in the TiVi700demonstration folder. 

 

2. Select Data to Sheet under the DropData pull-down menu. The DropDataSettings 

window will now open. 

 

 

                         
 

3. Click the OK button to open the DropDataSheet700 window. 
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4. Move the DropDataSheet700 window to a location next to the TiVi700Analyzer 

window. 
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5. Click the Show First Photo radio-button in the TiVi700 Analyzer window to display 

the first photo of the sequence. 

 

6. Click cell A1 in the Dropdata700 spread-sheet to insert the Image Mean value in 

focus into the DropData700 table. 

 

7. Click the Manual-button in the TiVi700 Analyzer window to display the next photo / 

image in the sequence. Click cell B1 in the DropData700 spread-sheet to insert the 

Image Mean value in focus into the DropData700 table. 

 

8. Click the Show Last Photo radio-button to display the last photo of the sequence.  

 

9. Click the Reverse-button and then the Manual button and then again click the 

Forward button to display photo A-0066. 

 

10. Click cell C1 in the Dropdata700 spread-sheet to insert the Image Mean value in 

focus into the DropData700 table. 

 

11. Click the Manual-button in the TiVi700 Analyzer window to display the next photo / 

image in the sequence. Click cell D1 in the DropData700 spread-sheet to insert the 

Image Mean value in focus into the DropData700 table. 

 

12. The DropData700 spread-sheet should now look like: 
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13. The mean TiVi-values of the two first and two last images are now inserted and 

displayed in the DropData700 spread-sheet. 

 

14. Repeat the procedure with photo sequences C and E. 

 

15. The DropData700 spread-sheet should now look like: 
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16. Click the Show SD radio-button to display the standard deviation values in the Table. 

 

17. Click the Clear All button to clear all edit boxes. 

 

18. Click the Set Row Names button and insert the names of the files in the corresponding 

edit boxes. 
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19. Click the OK button. The DropDataSheet 700 should now look like: 

 

                         
 

20. Click the Set Col Names button, click the Clear All button and insert the appropriate 

column names. Click the OK button. 
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21. Click the Save As button and save the table under a selected name and folder. 

 

22. Mark the cells holding numerical values and click the Reset button to empty the 

spread-sheet of data. 

 

 

23. Click the Load Table button and load the saved table again. 

 

24. Click the Bar Graph to display data as a Bar Graph. 
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25. The graph can be rotate by placing the mouse pointer in the diagram, pressing the left 

mouse button and moving the mouse. Click the Close button. 

 

26. Click the Export Data button to save the Table as an Excel document. 

 

27. Click the Close button to close the DropDataSheet700 window. 

 

            

Detailed description of DropData: 

 

DropData settings: 

 

1. Number of Rows edit box – to insert the actual number of rows in the DropData 

Sheet700 (up to 20). 

 

2. Number of Columns edit box – to insert the actual number of columns in the 

DropDataSheet700 (up to 10). 

 

 

3. OK button – to open a new DropDataSheet700 

 

DropDataSheet700:  

1. Table – fully editable table of max 20 x 10 dimension. Rows and Columns heading 

can hold alpha-numerical data while the spread-sheet cells can hold only numerical 

data. Clicking on a cell in the spread-sheet will automatically import and display the 

actual mean value (or standard deviation) of the image in focus in the TiVi700 

Analyzer. The width of a cell can be changed by pointing to the separator line in the 
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column heading, pressing the left mouse button and moving the point to a new 

position. 

 

2. Values above the spread-sheet displays the actual image Upper Limit and Lower 

Limit settings, the Mask setting and if the image is cropped as wells as the name of 

the actual photo and the name of the DropDataSheet700 (if saved). 

 

 

3. Save As button – to save the Table under a user selected name. 

 

4. Save button -  to save the Table under the name selected  with Save As. 

 

5. Load Table button – load a saved Table. 

 

 

6. Show Means radio-button - to display the actual image mean values. 

 

7. Show SD radio-button - to display the actual image standard deviations. 

 

 

8. Set Row Names – to open the Row editor window in which names of the rows can be 

inserted. 

 

9. Set Col Names – to open the Column editor window in which names of the columns 

can be inserted. 

 

 

10. Bar Graph – to open the Bar Graph window. 

 

11. Export Data – to export spread-sheet data to an Excel document. 

 

 

12. Reset – to reset the content of the table. Select an area by pointing at the first cell. 

Press the mouse button and the drag the mouse to a new cell thereby defining the area. 

Release the mouse button. The defined area of cells now is displayed in blue 

background colour. Click the Reset button. Alternatively cells can be selected by use 

of the Shift tangent. If the content of a single cell is to be deleted, point at the cell and 

print “0” in the cell edit box. 

 

13. Close – to close the DropDataSheet700. 
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Part 24 Organizer 

 

1. Select Organizer under the DropData pull-down menu. The Organizer 700 welcome 

window open. 

                                          

 

2. Click the New Organizer button to open a new Organizer. 
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3. Print Methyl Nicotinate in the Substance Selected edit box. 

 

4. Print This is my first Organizer project in the Comment area  

 

 

5. Click the User Defined Fields button to open the User Defined Fields window. 

 

                                                

6. Print ‘Additional Comments’ in the Field 1 edit box. Leave the other edit boxes blank. 

 

                                                

7. Click the Save & Close button. 

 

8. In the New Organizer 700 window click the Create New and Save button. 
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9. Save the Organizer under a selected name (e.g. T4) and folder. The Organizer 700 

named T4 now opens. 

 

                    
 

10. Click the Add New Subject button to add data for a new subject to the T4-table. The 

Add New Subject 700 now opens. Fill out Subject data. 

                                          

11. Click the Save & Close button. The Organizer 700 window should now look like: 
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12. Fill out data for two more subjects accordingly. 

                     

 

 

13. Click the Save Organizer to save the Organizer spread-sheet. 

 

14. Click the Export Data button to export data to an Excel spread-sheet. 
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15. Click the Close button to close the Organizer window. 

 

16. In the TiVi700 Analyzer window, click the First Photo button and load the A-

0001.jpg file. 

 

 

17.  Select Organizer from the DropData pull-down menu. 

 

18. In the Organizer700 window, click the Open Organizer and select the Organizer just 

saved (T4). 

 

 

 
 

19. Click the IDs to Sheet button to open the DropData 700 window with the subject 

identifiers imported. 

 

 



TiVi700 Analyzer Manual 

 

TiVi700Analyzer ver1.4 Page 54 

 

                             
 

20. Place the DropData700 window next to the TiVi700 Analyzer window. 

 

21. Click Set Col Names button and insert appropriate column  names. 

 

 

22. Transfer image data from the TiVi700 Analyzer to the spreadsheet (see section 

DropData above). 

 

Detailed description of the Organizer: 

 

Organizer700 settings window: 

 

1. New Organizer – to open a new Organizer. 

 

2. Open Organizer – to open a saved Organizer. 

 

3. Close – to close the Organizer700 window. 

 

New Organizer 700 window. 

 

1. Substance Tested - insert the name of the substance tested  here. 
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2. Comment – insert comments regarding the study. 

 

3. User Defined Fields - in addition to the standard fields in the Organizer, three 

optional fields can be inserted. The names of these fields are inserted in the edit boxes 

of the User Defined Fields window. 

 

4. Create New and Save – to create and save a new Organizer. 

 

5. Close – to close the New Organizer 700 window. 

 

Organizer 700: 

 

1. Table – holds data regarding subject ID (number) and Subject Identifier, Gender, Date 

of Birth, Address, Phone Number, e-mail, Test Data, Tester ID, Done (to check when 

the test for the actual subject is complete) and up to three user-defined fields. The 

table is fully editable. 

 

2. Add New Subject – opens window for including a new subject in the Organizer. 

This is done through the Add New Subject 700 window in which data of Subject 

Identifier, Gender, Date of Birth, Subject Address, Subject Phone Number, e-mail, 

Testing Date and Time, Tester Identifier n additional user-defined fields. Clicking 

Save & Close automatically insert the data into the Organizer. 

 

3. Remove Subject – to remove a subject from the Organizer. The unique subject ID 

number is not changed by this procedure. 

 

4. Export Data – to export the content of the Organizer to an Excel spread-sheet. 

 

 

5. IDs to Sheet – to export the subject ID data to a new DropDataSheet which is 

automatically generated and opened. 

 

6. Edit Comments – to display and edit comments related to the project. 

 

7. Save Organizer – saves the current content of the Organizer. 

 

8. Close – to close the Organizer. 
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Part 25 Software Installation Procedure 

 

If another version of TiVi700Analyzer is already installed, this must first be de-installed. 

Go to the Control Panel  Program (de-install a program) and select TiVi-1.1 Tissue 

Viability Imager (about 1GB) (or TiVi700Analyzer). Check “Yes” to de-install. 
 

Move the folder named TiVi700Analyzer to the install computer desktop from the installation 

USB memory stick. 

 
1. Click the TiVi700 Analyzer software setup icon in the TiVi700Analyzer folder. The installer 

will start to extract the TiVi700Analyzer.msi file. 

2. Click the Next button in the Welcome to the InstallShield Wizard for TiVi700Analyzer. 

3. Read the License Agreement. Check the “I accept the terms in the License agreement” radio-

button to continue with the installation procedure.  

4. Click the Next button. 

5. Click the Install button to install the software in the C:\Program Files 

(x86)\Wheelsbridge\TiVi700Analyzer folder. 

6. When the User Control Icon is displayed click on it. 

7. In the User Account Control click "Yes". The files will start to extract (will take about a 

minute or two. 

8. In the TiViAnalyzer – InstallShield Wizard check the Launch the Program checkbox (if not 

already checked. Click the Finish button. 

9. IN the User Account Control click the “Yes” button to start installation of the MATLAB 

libraries. The Winzip Self-Extractor – MCRINstaller.exe starts to extract the library files. 

 

10. In the MATLAB Runtime Installer click the Next button. 

11. Click the “Yes” radio button in the License Agreement and the click the Next button to start 

the installation of the MATLAB libraries.  

12. Click the Next button in the Folder selection window. 

13. Click “Yes” in the Folder Selection window as answer to the question “ Would you like to 

create it?” 

14. Click the Install button in the Confirmation window to start the installation (will take several 

minutes). 

15. Click the Finish button to complete the installation process. 

16. To start the TiVi700 Analyzer click the Launch TiVi700Analyzer icon on the desktop. 

If the program does not start correctly the Wheelsbridge window is probably not set up for 

reading and writing by the User. Proceed as follows to set the Wheelsbridge folder correctly: 

 

1. Right-click the Wheelsbridge folder located in the Program (x86) folder and select 

Properties. 

2. Select the Security tab. 

3. In the upper combo text box select User and check if permission to read and write to 

the folder is granted (lower combo text box). 

4. If not select Edit, select User in the upper combo text box. 

5. Check permission to read and write in the lower combo text box. 
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6. Click OK. 

7. The User can now read and write to the Wheelsbridge folder. 

 


